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Introduction

INTRODUCTION
SafePace Cloud is a web based, radar sign management solution developed by Traffic Logix. It uses the 
power of the SafePace Cloud engine to allow you to monitor and manage all aspects of your SafePace radar 
sign signs without leaving your desk. SafePace Cloud powered by Logix On Cloud allows you to do the 
following: 

» Monitor and manage your signs and their locations 

» Configure the display settings of your signs

» Specify displayed messages

» Handle alerts from the signs

» Generate and print statistical reports based on data gathered by the signs

Browser Requirements

SafePace Cloud is designed to work with the following Web browsers:

» Mozilla Firefox 

» Google Chrome 
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About this Quick Start Guide

About this Quick Start Guide
This Quick Start Guide is meant for  anyone who needs to set up SafePace Cloud powered by Logix On 
Cloud to work with a SafePace radar sign (GSM models) for the first time. It is intended to allow you to get 
up and running quickly with your radar sign and SafePace Cloud. It provides an introduction to SafePace 
Cloud and describes the basic use and configuration of the system including the following:

» Starting the sign 

» Setting display parameters for the signs

» Specifying the locations for your signs

» Assigning signs to locations

» Monitoring the real-time data from the signs

This guide presumes that you have already unpacked and set up your sign(s) as per the included installation 
instructions. Should you need more information on any of the features of SafePace Cloud, you can refer to 
the SafePace Cloud User Guide. 

TIP: We recommend that you set up your sign(s) in-house and that you follow the procedures in this 
guide to verify that the sign(s) operate well together with SafePace Cloud  before you install the sign(s) 
on location.

Workflow
The following procedure will allow you to get your SafePace radar sign up and running quickly.

1. Contact our Cloud On-Boarding team to schedule a brief introductory training session.

• Telephone: 1-866-915-6449 Option 4

• Email: cloudteam@trafficlogix.com

2. Turn on the SafePace radar sign. For  details, see Starting the Sign on page 9.

NOTE: By default, your radar signs would have been assigned to a specially created location prior to 
shipping. After you have turned on the sign you can do either of the following:

• Create a new location and assign the sign to it as described in the following steps, or
• Use the Find and Shift features of the sign to shift the location to the actual location of the sign. For more 

details on using these features, see Using GPS-Enabled Signs on page 26.

3. Create locations. For more details, see Creating Locations  on page 13.

4. Assign SafePace radar sign(s) to location(s). For more details, see Assigning Signs to Locations on 
page 16.

5. Specify the speed limits for the locations. For more details, see Configuring Express Mode for a Location 
on page 19.

6. Install SafePace radar sign(s) at the relevant location(s). For more details, refer to the  Installation Guide 
for your SafePace radar sign.

7. Review the traffic data. For details on reviewing traffic data, see the following:
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Workflow

• Monitoring Your Sign Locations on page 23

• Generating Reports and Charts on page 29
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Documentation Conventions

Documentation Conventions
This document uses the following formatting conventions:

Format Description

Bold Gray Used in procedures to indicate menu commands, interface controls 
and dialog box options.

Italics Used to place emphasis on certain words.

Monospace text Used for code samples and any information that the user enters.

Italicized 
monospace text

Used to indicate text that you should replace with your own. For 
example: In the Save As text box, enter c:\filename.ext where 
filename.ext is the name of the file you want to save.

> Used to indicate a sequence of commands (and sub commands) to be 
carried out in the displayed order. For example File > Exit means to 
open the File menu then choose the Exit command. This applies to 
menus from the main menu bar, context menus that appear when you 
right-click on the interface, and tiles in a tiled interface.

 

NOTE: Notes are used as reminders or to provide information of interest that supplements or 
emphasizes important points of the main text.

TIP: Tips are used to suggest alternative methods,  workarounds and/or shortcuts that are not essential 
but that you may find useful in a given situation.

CAUTION: Cautions are used to advise users of specific actions that could result in a loss of data.

WARNING: Warnings are used to advise users of specific actions that could result in personal physical 
injury or damage to equipment.
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Online Customer Area

Online Customer Area
Visit the Online Customer Area at (https://trafficlogix.com/customer-area/) to gain access to a range of 
resources including product documentation, software downloads and support videos, that will allow you to 
get up to speed with your Traffic Logix product.

NOTE: The Customer Area is password protected so you may need to  apply for a password if you 
haven't already obtained one.

Software Downloads

Provides convenient access to the latest versions of our software applications and utilities.

Support Videos 

Provides access to several videos that can help you get up to speed with your Traffic Logix product. 

Product Documentation

Provides access to the most recent versions of our product documentation. If you are unable to access our 
online documentation, please contact our Technical Support Department to discuss alternatives.
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GETTING STARTED WITH SAFEPACE CLOUD POWERED BY LOGIX ON 
CLOUD

Starting the Sign

There is no ON/OFF switch supplied with the radar speed signs. The sign immediately powers on when the 
power source is connected. When the sign is powered on it should go through a start up sequence. After the 
successful completion of the start up sequence, the sign displays one of the following messages.

» IP on - Displayed by static YOUR SPEED and static SPEED LIMIT signs

» GPRS Connect - Displayed by Variable Message Signs

NOTE: If the start up sequence ends with the sign displaying any other messages, please contact our 
Technical Support department immediately. See Contacting Technical Support on page 31.
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Signing In and Out of the User Interface

Signing In and Out of the User Interface

To sign in to SafePace Cloud:

1. Using your browser, navigate to the  URL (https://logixoncloud.com/). 

The SafePace Cloud Sign In page is displayed.

2. Specify your User ID and Password credentials, then click Sign In.

This signs you in to SafePace Cloud and displays the SafePace Cloud home page. 

If this is the first time you are signing in, you will need to accept the terms and conditions before the 
SafePace Cloud home page is displayed.

To sign out of SafePace Cloud:

» In the Menu bar, click the user menu then choose Logout.

This signs you out from SafePace Cloud and displays the sign in screen.
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Navigating the User Interface

Navigating the User Interface
As shown in the following image the home page of SafePace Cloud contains four icons plus a menu along 
the left edge. The icons allow you to navigate to the Dashboards for the different areas of the  application.

[Figure 1] The SafePace Cloud User Interface

Tiles

The following table describes the dashboard icons.

Tile Description

Parking Provides access to the Parking dashboards.

Radar Signs Provides access to the dashboards for the radar signs, radar switches 
and speed trackers.

Traffic Cameras Provides access to the traffic camera dashboards.

Side Menu Options

The following table describes the options available in the side menu.

Icon Name Description

Reports Allows you to generate charts and reports based on the 
data collected.

Map Displays a map of your locations  and allows you to see the 
status of, and selected real-time readings from, any 
associated devices.
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Navigating the User Interface

Icon Name Description

Alerts Allows you to process any alerts generated by SafePace 
Cloud. Not applicable to OpenSpace Cloud users.

Tools Allows you to configure and manage your installed devices.

Manage 
Locations

Allows you to set and manage locations.

Users Allows you to configure and manage user accounts and 
permissions.

System Allows you to configure the system settings.
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Creating Locations

Creating Locations 
In SafePace Cloud, a location represents the actual physical address where you place a device (for example a 
sign or camera). SafePace Cloud allows you to create multiple locations, to which you can later assign 
devices. 

To create a location:

1. In the side menu, click Manage Locations.

The Manage Locations page is displayed.

2. In the top menu bar, click Add Location.

The  Search Location box is displayed.

3. Do one of the following:

• In the Search Location box, type the address of the location you want to create.
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Creating Locations

• Navigate (zoom and drag) the map to the location you want to create, then double-click to place the 
location icon.

4. Specify the following parameters:

• Location Name – Type a name for the location.

• Contact User – Select a user who will be responsible for the device at this location.

• Group – Select a group for this location.

• Traffic Direction – (Optional) Specify the direction of traffic. This parameter is primarily used to 
differentiate between closely placed locations (for example: opposite sides of the same street).

• Time Zone – Specify the time zone of the location.

5. When you are finished, click Add New Location.
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Creating Locations

The new location is created and displayed in the location listings.
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Assigning Signs to Locations

Assigning Signs to Locations
In SafePace Cloud,  use the Manage Locations page to assign signs to locations. When you assign a sign to a 
location any data collected by that sign is then associated with that location in SafePace Cloud. Should you 
then assign the sign to a new location the data collected at the old location remains associated with that 
location. Any data collected from the new location is associated with the new location. However, it remains 
up to you to make sure that the sign is physically located at the specified location.

To assign a sign to a location:

1. In the side menu, click Manage Locations. 

The Manage Locations page is displayed.

2. From the Manage Locations page, select the location where you want to assign the sign.

The location listing expands.

3. Click the Radar Signs icon. 

The Assign Radar Sign dialog is displayed.

4. Click the Sign Type list box then choose the type of sign you want to assign from the list.
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Assigning Signs to Locations

5. Click the Sign list box then choose the sign you want to assign from the list.

The signs are identified by the serial number of the controller card and you can select any of the signs 
listed. 

NOTE: If you select a sign that is already assigned to another location, it will be removed from that 
location and reassigned to the current one.

6. Click the Sign Model list box then specify whether to use the existing settings for the location, or the 
default settings for your sign model.

• If this is a new location, either option will do, however, we recommend you review the radar sign 
settings for this location. For more details see Configuring Express Mode for a Location on page 19.

• If this is a pre-existing location, then you will probably want to select Keep Existing Settings.

7. When you are finished, click Save. 

8. When prompted, click OK to confirm your changes.

The listing for the location is displayed with a blue Radar Sign icon.

To remove a sign from a location:

1. Select the location from which you want to remove the sign.

The location listing expands.
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Assigning Signs to Locations

2. Click the Radar Signs icon. 

The Assign Radar Sign dialog box is displayed.

3. Click the Sign list box, then choose --none-- from the list.

4. Click Save.

The  Assign Radar Sign  dialog box closes and the sign is no longer assigned to  the location. The Radar 
Sign icon is dimmed in the location listing.
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Configuring Express Mode for a Location

Configuring Express Mode for a Location
Each location created in SafePace Cloud is assigned an express mode configuration, by default. Express 
Mode allows you to quickly and easily configure the Display Settings and Message Settings for a location. It 
is also the most common way to set constant (non-scheduled) Display  Message Settings. You can either 
configure the express mode settings  to suit your needs or select a schedule to use for the location.

To configure express mode for the location:

1. In the side menu, go to Tools > Radar Signs > Sign Settings.

The Radar Sign Settings page is displayed.

2. Find your location in the listing, then click the corresponding  link in the Display Settings column.

If the corresponding link in the Display Settings column is Express Mode, a dialog similar to the 
following is displayed.
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Radar Sign Display Settings

Otherwise, if a schedule has already been assigned to the location, a dialog similar to the following is 
displayed.

In this case, select the Express Mode tab.

3. Modify the necessary settings. For descriptions of the available parameters see the following sections.

• For Display Settings parameters, see              Radar Sign Display Settings below.

• For Messages parameters (only for signs with custom messaging), see              Radar Sign Message Settings 
on the next page.

4. When you are finished, click Save.

The specified Express mode settings are applied to the location.

Radar Sign Display Settings
The Display Settings allow you to control the speed display of the sign, including the range of speeds 
displayed, the speed limits and the use of the strobes. The following table describes the Display Settings that 
are available in SafePace Cloud.

Setting Description

Sign Type Displays the model family of the radar sign.

Switch to "Stealth" Mode Places the radar sign in a special mode which allows it to 
collect traffic data without displaying speeds or messages.

Display is Always ON Disables the Display Range setting and displays vehicle 
speed, speed limit or specified messages for all detected 
vehicles. 

note: This setting is disabled if the Sign Type selected is 
SP 100/250/400/450/475/EV11 or EV12.

Display Range Specifies the range of detected speeds for which the radar 
sign displays the following:
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Radar Sign Message Settings

Setting Description

• Vehicle speed (on static YOUR SPEED signs)
• Speed limit (on static SPEED LIMIT signs)
• Specified message (on variable message signs)

note: This setting is disabled  if the Display is Always ON or 
the Switch to "Stealth" Mode options are selected.

Speed Limit Specifies the speed limit for that location. This value is used 
to specify the speed limit to display on the static SPEED 
LIMIT signs, and also in reports to determine the number of 
speed limit violations.

Tolerated Speed Specifies the tolerated speed for the location. Used as an 
additional point of programming (for variable message signs) 
and in reports as an additional speed limit.

Flash Digits at Speed Flashes the digits on the sign, to get the driver’s attention, 
when the sign detects a vehicle traveling at or above the 
specified speed.

note: This setting does not apply to full matrix signs 
(SP 625/650/700/800, ES12FM, EV12FM, EV15FM 
and EV18FM). For these signs use the Flash Message 
at Speed setting.

Turn Strobe ON at Speed Turns on the Speed Violator Strobe when the sign detects a 
vehicle traveling at or above the specified speed.

Turn OFF Strobe above 
Maximum Displayed Speed

Turns off the  Speed Violator Strobe if the detected vehicle is 
traveling faster than the maximum speed  specified for the 
Display Range.

Show Digits in Red at Speed Changes the display color to red, when the sign detects a 
vehicle traveling at or above the specified speed.

note: This setting is only enabled if the Sign Type selected is 
a dual-color EV sign, such as the EV12 sign.

Radar Sign Message Settings
The Message Settings parameters  allow you to attribute specific messages to the specified speed intervals 
based on the Minimum Displayed Speed, Display Range, Speed Limit and Tolerated Speed Limit specified in 
the Display Settings. 

The message settings are only displayed if the selected Sign Type is a Variable Message Sign (e.g. 
SP600/700/800/EV12FM/ES12FM/EV15FM/EV18FM) or a Slow Down Sign (e.g. SP 625, EV 15SD/SL).  
The following table describes the Message Settings that are available in SafePace Cloud.

Setting Description 

From Minimum to Speed Limit Specifies what message to display when the sign detects a 
vehicle traveling between the minimum speed specified for 

SafePace Cloud Radar Sign Quick Start Guide p. 21



Radar Sign Message Settings

Setting Description 

the Display Range and the Speed Limit.

Red Specifies, when selected, that the sign will display messages 
in red when it detects a vehicle traveling in the respective 
speed range. 

note: Applies to EV12, EV12FM, ES12FM, EV15SD, 
EV15FM, EV18FM models. 

Alternate with speed Specifies, when selected, that the sign alternates between 
displaying the message and the detected speed of the 
vehicle. 

note: This checkbox appears for EV12FM, ES12FM, 
EV15FM and EV18FM models. 

Inside Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Speed Limit and the Tolerated 
Speed Limit.

Above Tolerated Range Specifies what message to display when the sign detects a 
vehicle traveling between the Tolerated Speed Limit and the 
maximum speed specified for the Display Range. 

Above Speed Range Specifies what message to display when the sign detects a 
vehicle traveling above the maximum speed specified for the 
Display Range.

Flash Message at Speed Specifies the following: 
• Whether or not to flash the displayed message to get the 

drivers' attention.
• The speed, above which, the detected vehicle must be 

traveling in order for the displayed message to be flashed.
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Monitoring Your Sign Locations

Monitoring Your Sign Locations
In SafePace Cloud, you can monitor your sign locations through either the Dashboards or the Map View. 
Monitoring your locations allows you to quickly see the status of the sign(s), if there are any issues with the 
power supply to the sign, as well as obtain a quick idea of the number and speed of the vehicles detected.  
The following table describes the  parameters displayed when monitoring your sign locations.

Parameter Description

Name Displays the name of the location.

Address Displays the address of the location.

Traffic Statistics Interval (Location pop-up only.) Displays the interval for the display of 
traffic statistics.

Traffic Direction Indicates the direction of traffic flow being monitored at the 
location.

Model Indicates the model of the radar sign currently assigned to 
the location.

Serial # Displays the serial number of the controller card in the radar 
sign currently assigned to the location.

FW# Displays the version of the firmware that is currently installed 
on the sign.

Vehicle Count Displays the number of vehicles detected during the time 
period specified by the Display Traffic Statistics Interval 
system parameter.

Avg. Speed Displays the average speed of the vehicles detected during 
the time period specified by the Display Traffic Statistics 
Interval system parameter.

85% Speed Displays the 85th percentile speed. This is the speed at or 
below which 85% of the detected vehicles traveled during 
the time period specified by the Display Traffic Statistics 
Interval system parameter.

Max. Speed Displays the maximum speed detected during the time 
period specified by the Display Traffic Statistics Interval 
system parameter.

Min. Speed Displays the minimum speed  detected during the time period 
specified by the Display Traffic Statistics Interval system 
parameter.

Speed Limit (Location pop-up only.) Displays the speed limit specified for 
the location.

Last Communication Indicates the last time that the sign communicated with the 
SafePace Cloud server.

(Last) Power Supply Indicates the last reported battery voltage for the sign.
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Monitoring Your Sign Locations

Parameter Description

Device Location (For GPS-enabled signs only.) Displays  the actual location (as 
opposed to the assigned location) of a  GPS-enabled sign. 
This allows you to determine whether or not a sign is 
physically located at the assigned location.
• Click the Find button.

Warning: Differences in GPS (For GPS-enabled signs only.) Moves the current location to 
the actual physical location of the sign, in cases where the 
physical location of the sign is different from the assigned 
location.
• Click the Shift Location button.

Monitoring Signs from the Dashboard

The Dashboard provides you with a tabular view of the real-time parameters for all of your signs. This 
allows you to monitor all of your signs at a glance.

To monitor your signs with the Dashboard:

1. In the side menu, go to  Tools > Radar Signs > Radar Signs Dashboard.

The Radar Signs Dashboard is displayed.

2. If necessary click the Expand  icon to expand the necessary group(s).

TIP: Click the column headers to sort the Dashboard listing based on that column. The arrow icon 
indicates the direction of the sort. You can click the header a second time to change the direction of 
the sort.
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Monitoring Your Sign Locations

Monitoring Signs in the Map View

The Map View allows you to monitor your radar signs based on their geographical location. It displays icons 
for each of your locations, and these location icons are color-coded to indicate the status of the radar sign 
at each location. The Map View also allows you to see a list of recent alerts generated by your radar signs. 

To monitor your signs in the Map View:

1. In the side menu, click the Map icon. 

The Map View page is displayed.

2. If necessary, click and drag the map to display the icons for the signs you want to monitor.

3. Click the icon for the sign you want to monitor.

The monitoring parameters for the sign are displayed in a pop-up window.
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Using GPS-Enabled Signs

Using GPS-Enabled Signs
SafePace Cloud supports the use of GPS-enabled signs. These signs are able to determine their actual 
location  through the use of a GPS antenna and report this location to SafePace Cloud. This allows you to 
determine whether or not a sign is at the location to which it has been assigned. It also allows you to match 
the location to which the sign is assigned with the actual physical location of the sign.

NOTE: GPS-enabled signs update their GPS coordinates approximately once per hour. If you move the 
sign, we recommend that you reboot the sign to immediately update the GPS coordinates..

Finding GPS-Enabled Signs

You can use the Find feature to determine where a sign is actually physically located. This feature uses the 
GPS coordinates reported by the sign to display the sign's actual physical location.

To find GPS-enabled signs:

1. In the side menu, click the Map icon. 

The Map View page is displayed.

2. If necessary, click and drag the map to display the icons for the signs you want to monitor.

3. Click the location icon for the sign you want.

The location pop-up is displayed.

4. In the location pop-up, click the Find button.
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Using GPS-Enabled Signs

An icon indicating the actual location of the sign is displayed.

Shifting Locations for GPS-Enabled Signs

If a GPS-enabled sign is placed somewhere other than the assigned location, in the Map View you can move 
the assigned location to where the sign was placed. This can be useful in cases where the sign may have been 
installed a few blocks away from it's intended location because that location was deemed not suitable.

NOTE: If the sign is actually placed at the assigned location, the Shift Location button is not displayed.

To shift locations for GPS-enabled signs:

1. In the side menu, click the Map icon. 

The Map View page is displayed.

2. If necessary, click and drag the map to display the icons for the signs you want to monitor.

3. Click the location icon for the sign you want.
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Using GPS-Enabled Signs

The location pop-up is displayed.

4. In the location pop-up, click the Find button.

An icon indicating the actual location of the sign is displayed.

5. In the location pop-up, click the Shift Location button.

The location icon moves to the actual location of the sign.
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Generating Reports and Charts

Generating Reports and Charts
All of the SafePace radar signs capture important traffic data such as vehicle counts, speeds, date and time. 
You can use the Report Wizard in SafePace Cloud to generate statistical reports and charts with this data. 
The following table describes the different types of reports available.

Report Description

Weekly Report The Weekly Report generates reports of various traffic 
statistics arranged by hours of the day and days of the week.

Summary Comparison Report The Summary Comparison Report allows you to compare 
traffic statistics for two separate periods of time.

Custom Report The Custom Report allows you to combine various traffic 
statistic parameters in one report.

Count by Speed Range Report The Count by Speed Range Report provides a count of the 
number of vehicles detected in different speed ranges (speed 
bins) for the specified period.

Power Supply Report The Power Supply Report displays a chart of the power 
supply values reported by the sign at the selected location 
during the specified period of time.

Synchronization Event Log 
Report

The Synchronization Event Log Report displays a log of 
synchronization events for the selected location.

To generate a report:

1. In side menu, go to Reports > Radar Signs.

The  Signs Report Wizard is displayed.

2. Click the Report Type list box, then choose a report from the list.

3. Click the Location list box, then choose a location from the list.

The report parameters are displayed.

NOTE: The parameters displayed will vary depending on the type of report you select.

4. Set the required parameters.
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Generating Reports and Charts

5. When you are finished, click Build.

The requested report is generated and displayed.

TIP: You may want to consider the following when reviewing reports:

• A Weekly Report of the total number of speed violations will allow you to see the time periods during an 
average week that have the highest number of speed violations.

• Displaying the daily values chart of this report can help you easily determine if there is a particular day of 
the week where speeding tends to occur.

• The 85% Speed can also be useful in determining periods in which speeding is a problem (for example 
periods during which the 85% Speed is higher than the speed limit or tolerated speed).

SafePace Cloud Radar Sign Quick Start Guide p. 30



CONTACTING TECHNICAL SUPPORT
If you have questions or comments regarding this document or SafePace Cloud powered by Logix On Cloud, 
please feel free to contact our technical support center by phone: 1 (866) 915-6449, or by email: 
support@trafficlogix.com
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